# Introduction to Excel 2013

## Contents

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Excel 2013 Screen</td>
<td>3</td>
</tr>
<tr>
<td>File Tab</td>
<td>3</td>
</tr>
<tr>
<td>Ribbon</td>
<td>4</td>
</tr>
<tr>
<td>Tabs</td>
<td>4</td>
</tr>
<tr>
<td>Contextual Tabs</td>
<td>4</td>
</tr>
<tr>
<td>Groups</td>
<td>5</td>
</tr>
<tr>
<td>Command buttons</td>
<td>5</td>
</tr>
<tr>
<td>More Button</td>
<td>5</td>
</tr>
<tr>
<td>Dialog Box Launcher</td>
<td>5</td>
</tr>
<tr>
<td>Gallery</td>
<td>5</td>
</tr>
<tr>
<td>Quick Access Toolbar</td>
<td>6</td>
</tr>
<tr>
<td>Views on the Status Bar</td>
<td>7</td>
</tr>
<tr>
<td>Zooming on the Status Bar</td>
<td>8</td>
</tr>
<tr>
<td>Excel Terminology</td>
<td>8</td>
</tr>
<tr>
<td>Entering and Editing Data</td>
<td>9</td>
</tr>
<tr>
<td>Entering Data</td>
<td>9</td>
</tr>
<tr>
<td>Editing Data</td>
<td>10</td>
</tr>
<tr>
<td>Deleting Data</td>
<td>10</td>
</tr>
<tr>
<td>Navigating Around Worksheets</td>
<td>10</td>
</tr>
<tr>
<td>Selecting Parts of a Worksheet</td>
<td>11</td>
</tr>
<tr>
<td>Working with Worksheets</td>
<td>12</td>
</tr>
<tr>
<td>Inserting Worksheets</td>
<td>12</td>
</tr>
<tr>
<td>Deleting, Renaming, Moving Copying Worksheets</td>
<td>12</td>
</tr>
<tr>
<td>Reordering Worksheets</td>
<td>12</td>
</tr>
<tr>
<td>Assigning Tab Colours</td>
<td>13</td>
</tr>
<tr>
<td>Selecting a Group of Worksheets</td>
<td>13</td>
</tr>
<tr>
<td>Inserting, Deleting and Resizing Columns/Rows</td>
<td>14</td>
</tr>
<tr>
<td>Inserting Columns/Rows</td>
<td>14</td>
</tr>
<tr>
<td>Deleting Columns/Rows</td>
<td>14</td>
</tr>
<tr>
<td>Right Click Method for Inserting and Deleting Rows and Columns</td>
<td>14</td>
</tr>
<tr>
<td>Resizing Columns/Rows</td>
<td>15</td>
</tr>
<tr>
<td>Copying/Moving Data</td>
<td>15</td>
</tr>
<tr>
<td>Cut, Copy and Paste Commands</td>
<td>15</td>
</tr>
<tr>
<td>Drag and Drop</td>
<td>16</td>
</tr>
<tr>
<td>Formulas and Functions</td>
<td>17</td>
</tr>
<tr>
<td>Operators</td>
<td>17</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>--------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Entering Formulas for Summing Numbers</td>
<td>18</td>
</tr>
<tr>
<td>More Notes on AutoSum</td>
<td>20</td>
</tr>
<tr>
<td>Order of Operators</td>
<td>21</td>
</tr>
<tr>
<td>Percentage Formulas</td>
<td>21</td>
</tr>
<tr>
<td>Interpreting Formula Error Messages</td>
<td>22</td>
</tr>
<tr>
<td>Reference to Cells in Other Worksheets</td>
<td>22</td>
</tr>
<tr>
<td>Copying Formulas</td>
<td>22</td>
</tr>
<tr>
<td>Relative and Absolute Referencing</td>
<td>23</td>
</tr>
<tr>
<td>AutoFill</td>
<td>24</td>
</tr>
<tr>
<td>Page Margins</td>
<td>25</td>
</tr>
<tr>
<td>Page Orientation</td>
<td>26</td>
</tr>
<tr>
<td>Print and Print Preview</td>
<td>26</td>
</tr>
</tbody>
</table>
The Excel 2013 Screen

File Tab
Clicking the File tab will display a list of commands which relate to the management of Excel and Excel worksheets (as opposed to managing the content). Examples of commands found under the Office button include: New, Open, Print, Save, Share, Export.

TIPS:
- If the Open option is selected on the left, on the right you will see a list of recent Excel files you worked with. Click on an Excel file name to open it.
- The Options button allows you to customize Excel.
**Ribbon**

The ribbon contains all the commands for working with the spreadsheet content. It has been arranged in a way so the most popular commands are in an optimal position and commands relating to a particular activity are grouped together. The ribbon is divided into 9 tabs in Excel.

![Ribbon Image](image)

TIP:

It is possible to customize the ribbon. You can create more tabs and assign commands to them.

**Hiding and Displaying the Ribbon**

It is possible to hide the ribbon temporarily in order to make more room on screen for you to work. To do this double click on the active tab. This will leave all the ribbon tabs in view but collapses the active tab contents, as shown below:

![Ribbon Hiding Image](image)

To bring back the ribbon double click on any tab.

**Tabs**

The ribbon is divided into 9 tabs in Excel: File, Home, Insert, Page Layout, Formulas, Data, Review, View and PowerPivot.

Each tab focuses on a major activity area. For example, the Home tab is dedicated formatting text and cells. Each tab is further divided into groups.

**Contextual Tabs**

Contextual tabs only appear when you select particular worksheet elements, thereby making further appropriate commands available only when they are required. This ensures that the ribbon doesn’t get too cluttered up and commands stay hidden until they are needed. Contextual tabs always appear on the far right of the ribbon.

**EXAMPLE OF CONTEXTUAL TABS:**

When you select a chart in your worksheet the Design and Format contextual tabs appear.

![Contextual Tabs Image](image)
Groups
Each tab is divided into groups and it is these groups which contain the command buttons. For example, the Home tab has 7 groups:

Command buttons
The command buttons carry a command or display a menu of commands. Some of the commands give you a live preview. (See the Gallery section below for more details on live preview)

More Button
A More button may appear below any scroll bar on the tabs. Clicking this will open up a gallery showing options.

Dialog Box Launcher
Some groups have a Dialogue box launcher button. Clicking on this will open a dialog box or a task pane.

Gallery
A Gallery opens up when you click on any More button located below any scroll bar on a tab. Each gallery is a collection of thumbnail graphics which provides you with a visual way of browsing results of commands. The innovative feature of these galleries is that they offer you live previews.

Live Preview
When you hover your mouse over a gallery item you will see a preview of how that option will look on your worksheet or selected text/element although you have not yet select that item or type of formatting, i.e. you are being shown a live preview. You can experiment with options without actually applying the changes - this saves you ever having to Undo if you decide you don’t like it and then having to locate the next option. Once you find a gallery item you wish to apply click on it.

TIP:
To close a gallery if you do not wish to make a selection press ESC on your keyboard.
Quick Access Toolbar

The Quick Access Toolbar is the only permanent toolbar in Excel and is located either above or below the ribbon. Its purpose is to hold the most frequently accessed commands and starts out with the commands: Save, Undo and Redo.

Everyone is encouraged to customise the Quick Access toolbar as it can significantly speed up their work.

Customizing the Quick Access Toolbar 1 – Adding Commands

Extra commands can easily be added to the Quick Access Toolbar.

To add commands to the Quick Access Toolbar:

1. Click on the Customize Quick Access Toolbar button at the end of the toolbar.
2. Select one of the suggested commands from the drop down list
   OR,
   Click on the More Commands option and use the dialogue box which opens (shown opposite). To add more commands click on the command you require from the list on the left and click on the Add button. Click OK when you are finished.

Useful commands to add:
- Print Area
- Insert Chart
- Filter
- Sort
- New Comment

TIP:
The quickest way to add a command to the Quick Access Toolbar is to right click the command in its Ribbon tab and select the Add to Quick Access Toolbar option.
CUSTOMIZING THE QUICK ACCESS TOOLBAR 2 – CHANGING LOCATION

If you use the Quick Access Toolbar a lot you may find it more convenient to have it located under the ribbon for quicker access. Also, it may have become so big that it will fit better in the space under the ribbon.

To move the Quick Access Toolbar to be below the ribbon:
1. Click on the Customize Quick Access Toolbar button
2. Select Show Below the Ribbon

A customized Quick Access Toolbar placed below the ribbon with many commands added

Views on the Status Bar

Shortcut buttons for changing views are located on the right side of the status bar.

The Status Bar

PAGE LAYOUT VIEW

The Page Layout view is a very useful view if you do a lot of printing. It allows you to work and type into a worksheet whilst the page margins, headers and footers are displayed. All these displayed elements may be directly edited.

For example, click into the header area and edit it.

TIP:
To temporarily hide the margins in this view click in the space just above the top margin
**Zooming on the Status Bar**

The zooming tools are now on the status bar. To zoom in or out either:

- Use the slider at the end of the status bar. It ranges from 10% to 500%
- Click on the – or + buttons and you jump in increments of 10%
- Click anywhere between the – and + signs
- Click on the Zoom Level box and select from the Zoom dialogue box

---

**Excel Terminology**

**CELL**

A cell is an intersection of a row and a column. Each cell has a unique address, composed of the cell’s column and row name, and this is referred to as the Cell Reference. For example the top left cell of any worksheet is A1.

**ACTIVE CELL**

The active cell is the currently selected cell. It will have a box around it and the address of the cell will be displayed in the Name box.

**RANGE OF CELLS**

When using a spreadsheet, cells are often worked on together as a range. When selected all cells in the range will have a box around them. Reference to a range is made using the top left cell and the bottom right cell, separated by a colon (e.g. A1:D6). A range of cells is selected by dragging with the mouse over the required cells. When a range is selected, the first cell chosen remains the active cell.

**FORMULA BAR**

Consists of a Name Box and Entry Line

**WORKSHEET**

Each worksheet is divided into columns, rows and cells, separated by gridlines. There are 16,384 columns (labeled A to Z to AA to XFD) and 1,048,576 rows (numbered). To move from worksheet to worksheet click on the worksheet tabs at the bottom of the screen.

**WORKBOOK**

When Excel is started a workbook is opened. It consists of several worksheets, usually three, when first opened. Any worksheet can be deleted or more can be inserted.

**SCROLL BARS**

Scroll bars are used to scroll to parts of a worksheet that are not displayed in the window.

**STATUS BAR**

This can be very useful as it often offers prompts when performing spreadsheet tasks.
Entering and Editing Data

**Entering Data**

Data in the form of numbers, text or formulas can be entered into a cell.

1. Click in a cell
2. Type the data using the keyboard. The data is displayed in the entry line of the formula bar as well as the cell itself as it is being entered.

   **NOTE:**
   Once you start entering data into a cell, the Formula Bar buttons are activated:

   ![Formula Bar Buttons](image)

   - **Cancel** button
   - **Enter** button

3. When you have typed in all you require into a cell you need to confirm the data entry. There are various ways of doing this - one way is to click on the **Enter** button on the Formula bar.

   **TIP:**
   If you make a mistake while you are entering data click the **Cancel** button on the Formula Bar to discard the entry and clear the cell. This will also switch off the formula bar buttons. Alternatively press the **ESC** key on the keyboard.

**DIFFERENT METHODS FOR CONFIRMING DATA ENTRY**

We see from above that the **Enter** button on the Formula Bar will confirm entry but there are alternative methods of doing this, and some methods are more efficient than others. Which method is most efficient will depend upon where you wish to type next as each different method will result in a different cell being made the active cell once the confirmation has been made. For example if you are typing a list down a column using the **Enter** key on the keyboard after typing each item, this will not only confirm the data entry but it will also make the cell below active.

The following table summarizes the different methods of confirming data entry and where the position of the active cell will move to:

<table>
<thead>
<tr>
<th>Method of Confirming Entry</th>
<th>Position of active cells</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter button on Formula Bar</td>
<td>Active cells remains the same</td>
</tr>
<tr>
<td>Enter key on keyboard</td>
<td>Cell below original becomes active</td>
</tr>
<tr>
<td>TAB key on keyboard</td>
<td>Cell to right of original becomes active</td>
</tr>
<tr>
<td>One of 4 Cursor keys on keyboard</td>
<td>Cell in direction of cursor key becomes active</td>
</tr>
<tr>
<td>Click any other cell in worksheet</td>
<td>New cell click become the active cell</td>
</tr>
<tr>
<td>(do not use this method when entering formulas)</td>
<td></td>
</tr>
</tbody>
</table>
DEFAULT TEXT FORMATTING

Excel applies the following defaults to text:

- Text is automatically aligned left. Note that this includes a string of numerical characters which include hyphens or spaces, such as National Insurance numbers or telephone numbers.
- Numbers are automatically aligned right.
- Text size is 11 points and the font is Calibri by default (but this may depend upon your installation and set up).
- Text does not wrap unless you tell it to, i.e. if you type text that exceeds the width of a column it will appear to flow into the next cell if that cell was empty. If the next cell is not empty the overflowing text that does not fit into the cell will be hidden.

Editing Data

WHEN A MINOR ADJUSTMENT IS REQUIRED IN A LONG ENTRY

1. Click once in the cell requiring the edit
2. Click inside the text in the Formula Bar (a cursor or insertion point appears in the Formula Bar) and carry out any edits.
3. Confirm the entry, e.g. click on the Enter button
   Or,
1. Double click on the cell to open it for editing and edit directly in the cell, then confirm the entry.

WHEN YOU WISH TO REPLACE AN ENTRY WITH A COMPLETELY NEW ONE

1. Click on the cell which has the entry you wish to replace.
2. Type the new entry (the whole original entry is replaced by new entry without the need to press Delete)
3. Confirm the data entry, e.g. click on the Enter button or Enter key on keyboard.

Deleting Data

1. Select the cell or range which has the data you wish to delete and do one of following:
   - Press the Delete key on the keyboard
   - Go to the Home tab, locate the Editing group, click on the Clear command button and then on the required option. For example, Clear Content.

Navigating Around Worksheets

Mouse click
Cursor keys on keyboard
Enter

Click any cell with your mouse
User the cursor keys to move in the direction of the arrow
Moves one cell down
Tab 
Moves one cell to the right
CRTL+HOME  
Moves back to cell A1
HOME  
Moves to the first cell in a row
CRTL+Cursor keys  
Moves to the next start or end of a data region

For example if you click in cell A3 in worksheet shown below, and keep pressing CRTL+→ you will jump to the areas indicated below by the numbered ovals with each successive press. One more and you will jump to the very end of the worksheet

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
<th>I</th>
<th>J</th>
<th>K</th>
<th>L</th>
<th>M</th>
<th>N</th>
<th>O</th>
<th>P</th>
<th>Q</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>3440</td>
<td>3441</td>
<td>22</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>2722</td>
<td>2723</td>
<td>33</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>42</td>
<td>4441</td>
<td>4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>2722</td>
<td>2722</td>
<td>34</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>23</td>
<td>3444</td>
<td>32</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>2440</td>
<td>2491</td>
<td>2932</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>4234</td>
<td>3944</td>
<td>3444</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>43</td>
<td>3443</td>
<td>2443</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

CRTL+END  
Moves to the last cell in the worksheet
Scrolling  
Move around the screen
CRTL+PgDown  
Moves to the next worksheet in the workbook
CRTL+PgUp  
Moves to the previous worksheet in the workbook

Selecting Parts of a Worksheet

Different parts of a worksheet can be selected in different ways. The click and drag method is not always the quickest or most convenient. It is therefore useful to be familiar with all methods of selecting so you can use the most appropriate for each situation.

To select: 
Instruction:
One cell:  
Click on one cell
Range of Cells:  
Click and drag with the mouse
Or,  
Click in one cell, then hold down the Shift key and click in another cell. i.e. perform a ‘Shift-Click’
E.g. Click in cell A1, then Shift-Click in cell C3. This range can be referred to as A1:C3
Whole column or row:  
Click on the column letter or row number
More than 1 adjacent column/row:  
Drag through the column letters or row numbers
More than 1 non-adjacent column/row: Select the first column/row, hold down CTRL and select the subsequent columns/rows

More than 1 range of cells: Select the first range, hold down CTRL and select the subsequent ranges

Whole Workbook: Click in the very top right corner

**Working with Worksheets**

By default each new workbook is provided with one worksheet but you can add any number of extra worksheets. This allows you to keep a varied and large amount of information together in one workbook (Excel file).

**Inserting Worksheets**

Click on the Insert Worksheet button (shown in the diagram above). Any inserted worksheet will be given a default name, e.g. Sheet2.

To move from worksheet to worksheet click on the worksheet tab for the worksheet you require at the bottom of the screen.

**Deleting, Renaming, Moving Copying Worksheets**

Right-click one of the worksheet tabs and then select the command you require from the drop down menu which appears.

**TIP:**
When renaming tabs it is best to give them short names, especially if you have a large number of worksheets in your workbook.

**Reordering Worksheets**

To reorder a worksheet click on the worksheet tab and drag it to the position you require. A small triangle will indicate where the worksheet will be dropped if you release the mouse button.
Assigning Tab Colours

1. Right click a tab and select Tab Colour from the drop down menu.
2. Select a colour from the list available or click on More Colors for further options.

NOTE:
Whenever a tab is selected its background becomes white. In the case of a coloured tab, when it is selected the colour will be reduced to a coloured line under the tab name.

Selecting a Group of Worksheets

You may wish to select a group of worksheets so you can apply the same overall formatting to all the worksheets or wish to enter the same information into more than one worksheet at a time. This is useful if you are creating a workbook with a worksheet for every month of the year, and you wish to set up identical tables in each worksheet.

To select a group of worksheets:

1. Select the first worksheet
2. Either:
   - Hold down the SHIFT key and click on the last worksheet you wish to select. (this selects adjacent worksheets)
   
   For example, click on mar, then SHIFT-Click on jul
   The worksheets between Jan and May will be grouped (selected).

   Or,

   - Hold down CTRL and click on each worksheet you wish to select. (this allows you to select non-adjacent worksheets)

   For example, click on jan, then CTRL-Click on mar and jun
   Only the worksheets you clicked will be grouped (selected)

You may now enter and format it in any one of the worksheets and that data and formatting will appear in all selected worksheets.

To ungroup the worksheets:

Either:
   - Click on a worksheet which is not selected (if all are selected click on any worksheet)

Or,
   - Right click on any grouped worksheet tab and select Ungroup Sheets
Inserting, Deleting and Resizing Columns/Rows

Whole rows and columns can be added to or removed from a worksheet, causing the adjacent cells/rows/columns to be repositioned and re-referenced.

**Inserting Columns/Rows**

1. Click in a cell in the column which is to the right of where you wish to insert the new column or in a cell in the row which is below where you wish to insert a new row.
2. Go to the **Home** tab, locate the **Cells** group and click on the lower half of the **Insert** command button.
3. Select the option you require, e.g. **Insert Sheet Columns**.

**NOTE:**
If you wish to insert more than one adjacent column, follow the instructions above, but for step 1 select the exact number of columns you require (by clicking on the column headings e.g. A, B, C) and then carry out steps 2 and 3.

**Deleting Columns/Rows**

1. Click in a cell of the row or column you wish to delete, or select all the rows or columns you wish to delete.
2. Go to the **Home** tab, locate the **Cells** group and click on the lower half of the **Delete** command button.
3. Select the option you require, e.g. **Delete Sheet Columns**.

**Right Click Method for Inserting and Deleting Rows and Columns**

1. Select the whole row(s) or column(s) you wish to delete or add a row/column next to
2. Right-click anywhere on the selected area
3. From the drop down menu which appears select **Insert** or **Delete**.

The dialogue box opposite may appear asking you to clarify what exactly it is you wish to insert or delete.
**Resizing Columns/Rows**

Columns and rows may be resized in various ways:

**Resizing with Click and Drag**

The width of each column or height of each row in a worksheet can be adjusted using the mouse. When the mouse pointer is moved between two column or row headings (e.g. A and B or 1 and 2) it changes shape to a two headed arrow. When you see the two headed arrow appear click and drag to the desired position.

\[\text{e.g. to resizing column D}\]
- Click between the D and E column heading and drag either to the right or left to the position you require.

**Resizing with AutoFit**

To automatically resize a column with AutoFit double click the right boundary of the column heading. What Excel will do is to look at all the entries in the column and will resize the column to match the width of the widest entry.

**Resizing Using the Format Command Button**

1. Go to the **Home** tab, locate the **Cells** group and click on the **Format** command button.
2. Select either **Column Width** or **Row Height** to bring up the appropriate dialogue box.
3. Enter the measurement you require and click **OK**.

**NOTE:**
Only a value between 0 – 255 will be accepted.

**Copying/Moving Data**

It is possible to copy and move data from cells to cells within a worksheet, across to a different worksheet or even to a different workbook. This can be achieved using one of several methods.

**Cut, Copy and Paste Commands**

The Cut, Copy and Paste commands work in the same way here as they do in other Windows programmes.

1. Select the cell(s) containing data you wish to copy/move
2. Select the **Cut** or **Copy** command using one of the following:
• Go to the **Home** tab, locate the **Clipboard** group, click on either the **Cut** or **Copy** command buttons

• Right click the selected cell(s) and select either **Cut** or **Copy**

• Use the **CTRL+X** or **CTRL+C** keyboard shortcut keys

3. Click in the cell where you wish to copy/move the data to

4. Select the **Paste** command using one of the following:

• Go to the **Home** tab, locate the **Clipboard** group, click on the top half of the **Paste** command button

• Right click the selected cell(s) and select **Paste**

• Use the **CTRL+V** keyboard shortcut keys

• Press the **Enter** key on the keyboard

**NOTES:**

• When you copy, and then use the **Paste** command the data remains on the clipboard so you can repeat the paste many times. The cell containing the original data will have a broken line around it indicating that the data is still on the clipboard. To get rid of the broken line around the cell containing the original data AND remove the data from the clipboard, press the **ESC** key.

• When you use the **Cut** command to move data, or if you use the **Enter** key to paste data you have copied you will find that you can only paste once as the data does not remain on the clipboard. To paste again you will have to copy or cut again.

**Drag and Drop**

**MOVING DATA**

1. Select the cell(s) containing the data you wish to copy/move

2. Carefully move your mouse pointer over the black outline of the active cell or range of cells until the four-headed arrow ‘move’ symbol appears on the mouse pointer.

3. Now click and drag the cell contents to another cell.

**COPYING DATA**

Repeat the above procedure but this time before you click and drag press and hold down the **CTRL** key. The four-headed arrow ‘move’ symbol will change to indicate a Plus sign ‘copy’ symbol. Now if you click and drag to another cell you will have copied the contents.
Formulas and Functions

One of the most fundamental features of spreadsheets is the ability to perform calculations using data contained in the cells and to display the results. This is achieved by entering formulas.

NOTES ON FORMULAS:

- A formula is entered in the cell in which the result is to be displayed
- A formula must always begin with =
- A formula includes arguments (such as cell references, text or numbers) and operators (such as + - / *)
- Once a formula has been entered and confirmed in a cell, when you later click the cell only the calculation result will be displayed in that cell whereas the full formula will be displayed in the Formula Bar. If you double click on a cell containing a formula the full formula will be displayed and will be ready for you to edit.
- Avoid typing numbers into a formula. Wherever possible, instead of typing in a number refer to another cell reference with that number in it.

NOTE ON FUNCTIONS:

A function is a built-in formula such as sum, average, max (the highest value), count. A formula can be thought of as the function but with the arguments.

Operators

Operators are mathematical symbols. They tell Excel what kind of calculation you want to perform.

Examples of Arithmetic Operators

- Addition + (Shift= on keyboard or use the number pad)
- Subtraction - (dash on keyboard or use the number pad)
- Multiplication * (Shift8 on keyboard or use the number pad)
- Division / (/ on keyboard or use the number pad)

Examples of Comparison Operators

- Greater than >
- Less than <
- Greater than or equal to >=
- Less than or equal to <=
- Not equal to <>
**Entering Formulas for Summing Numbers**

Summing is one of the most commonly used functions in Excel. There are many ways to carry this out. Some procedures take longer than others. Several methods of creating a formula for summing or using the Sum function are provided in this chapter. You would not normally select the first two methods for summing a column of numbers (as these methods are quite time consuming) but I have provided all methods for you in the hope that if you can understand how to construct a formula from basics you will be able to work out how to create formulas to meet your specific needs.

The most efficient way of summing columns of data is to use Method D – using the **AutoSum** button.

The example for all methods described below will be finding the sum of four numbers in cells A1:A4.

**METHOD A – TYPING FULL FORMULA**

1. Click in the cell where you want the result to appear. In this case, the first vacant cell under the 4 cells we are summing. (A5)
2. Type the full formula

   \[=A1+A2+A3+A4\]

**NOTE:**
As you type the cell references the cells get an outline in a colour corresponding to the cell reference in the formula.

3. Confirm the entry (e.g. by pressing Enter button or the appropriate keyboard key)

**NOTE:**
The result of the calculation is displayed in the cell containing the formula and the full formula is displayed on the formula bar when A5 is the active cell.

**METHOD B - POINT AND CLICK METHOD**

1. Click in the cell where you want the result to appear. In this case, the first vacant cell under the 4 cells we are summing. (A5)
2. Type \[=\]
3. Click on the first cell you want to include in the formula (A1)
4. Type an addition operator (+)
5. Click on next cell you want to include in the formula (A2)
6. Repeat steps 4 and 5 until the entire formula is entered. Make sure you do not end the formula with an +
7. Confirm the entry e.g. by pressing Enter button

**NOTE:**
The resulting formula will look identical to the formula from Method A.
METHOD C – USING SUM IN FORMULA

Sum is an example of a function.

1. Click in the cell where you want the result to appear. In this case, the first vacant cell under the 4 cells we are summing. (A5)
2. Type =SUM(
3. Either
   • type in the range of cells you wish to sum, in this example A1:A4
   Or,
   • select the cells you wish to sum using the mouse
4. Confirm the entry e.g. by pressing Enter button

METHOD D - AUTO SUM BUTTON

To use AutoSum either:

1. Click in the cell where you want the result to appear. In this case, the first vacant cell under the 4 cells we are summing. (A5)
2. Click the upper part of the AutoSum button (Formulas tab, Function Library group)
3. Check the formula entered by Excel, especially that the correct range of cells has been chosen.
   TIP: If an incorrect range of cells has been selected by Excel simply click and drag to select the correct range.
4. Confirm the entry.
Or,
1. Select the range of cells to be added and also the cell where you wish to place the formula. In this case it will be cells A1:A5
2. Click the upper part of the AutoSum button
   In this case the formula is entered and confirmed automatically (as you yourself selected the range there can be no error by predicting the range you required).
**METHOD E – SELECT THE FUNCTION FROM THE DROP DOWN MENU ON THE FORMULA BAR**

1. Click in the cell where you want the result to appear. In this case, the first vacant cell under the 4 cells we are summing. (A5)

2. Type \( = \)
   
   You will notice the Name Box part of the Formula Bar has changed to a functions button with a down arrow to allow you to call up a list of commonly used functions.

3. Either click on the Function button if it is the function you are after,
   
   Or,
   
   Click on the down arrow and select the function you require from the drop down list.

4. Check the range in the dialogue box which appears and click OK

### More Notes on AutoSum

Further to the introduction on AutoSum on page 19 – *Method D AutoSum button* here are a few more notes on using AutoSum.

**AutoSumming Many Columns/Rows in One Go**

If you have a table of data and wish to sum all the columns and rows in one go you may do so very quickly. To do this:

1. Select all the rows and columns of data, AND one blank cell under each column and to the right of each row. (see opposite)

2. Click the **AutoSum** button

   Each column and row will now contain the correct formula to sum the cells above in the case of columns and to the left in the case of rows.

### Using the AutoSum Button for Other Functions

The **AutoSum** button can be used to quickly create formulas for other commonly used functions. Follow the instructions as for using AutoSum to create a formula to sum, only instead of clicking on the **AutoSum** button click on the down arrow and then select the function you require from the drop down menu.
**Order of Operators**

Take care when you are writing formulas which contain several operators.

**NOTE:**
- Formulas are calculated from left to right.
  E.g. 15/3+2 is 7 and not 3.
- Multiplication and division are always done before any addition or subtraction.
- Any operation in parentheses is calculated first.

E.g. where C3 is 7 and C4 is 2

\[ \begin{align*} 
  &= C3+C4 \times 100 \quad \text{equals} \quad -193 \\
  &= (C3-C4) \times 100 \quad \text{equals} \quad 500 
\end{align*} \]

<table>
<thead>
<tr>
<th>Operator Order summary</th>
<th>X</th>
<th>/</th>
<th>+</th>
<th>-</th>
</tr>
</thead>
</table>

**Percentage Formulas**

To write a percentage formula you would expect to have a formula such as \( \frac{B2}{B7} \times 100 \). The result will be expressed in the cell just as a number without a percentage symbol.

You can use the **Percent Style** command button (Home tab, Number group) to allow you to express all your formula results as percentages. To use this button select all the cells that are to have the percentage formula and then click on this button. As the effect of this formatting will multiply any value in the cell by 100, when you write your formula to calculate percentages you must remember to leave the formula expressed just as a fraction and not multiply by 100.

E.g. Write formula as \( \frac{B2}{B7} \) and apply the **Percent Style** format to the cells.
**Interpreting Formula Error Messages**

You may come across any of the following error messages when you are creating formulas. An error message will appear when you ask the formula to do something that will prevent it from calculating. Here are just a few examples of the most common error messages you might see:

- #####  
  This means that the column is not wide enough to display a numerical value. Simply widen the column to allow the whole value to display.

- #DIV/0!  
  Formula is attempting to divide by zero. To fix this change the value or cell reference so that the formula does not divide by zero.

- #NAME?  
  Excel does not recognize the text in a formula. Check the spelling of your function or check that a name exists.

Whenever an error message appears you will also see a green marker in the top left of the cell.

If you select a cell with an error/green marker an information symbol will appear. Click on this symbol to display a drop down menu which offers you many choices including a Help on this error option. This option will take you to a help file which will explain the message error in detail.

**Reference to Cells in Other Worksheets**

When you wish to refer to a cell in another worksheet when writing a formula refer to the cell in the following way:

```
worksheetname!cellreference  e.g. Budget!H2
```

**Copying Formulas**

When setting up a worksheet it is often necessary to use the same formula for a series of rows or columns of data. Or you may wish to use the same formula in another area of the worksheet or in a separate worksheet altogether. To save time, when the first formula has been entered, it can be copied into another cell or a series of cells. There are several ways to copy formulas and the methods are the same as for copying data described elsewhere in this guide. Methods include:

- Copy and Paste  
  See page 15

- Drag and Drop  
  See page 16

- AutoFill  
  See the chapter on AutoFill on pages 24-25

When you copy a formula you will be pleased to hear that the arguments (cell references) will usually change to reflect the formula’s new position. This is because arguments are set to have relative referencing by default. This will be a great help to you in many cases,
but in some situations it will not be what you want to happen. When copying formulas do carefully check that you are happy with any argument changes which have occurred. There is more information on this in the next chapter - *Relative and Absolute Referencing*.

**Relative and Absolute Referencing**

Understanding relative and absolute references will help you when you come to copy a formula to another location and the arguments have not correctly changed to reflect the formula’s new position.

**CELL REFERENCING** is when you specify a cell or range of cells in a formula.

**RELATIVE REFERENCING.** Use relative referencing when you want a cell reference in a formula to adjust to its new location when you copy the formula.

**ABSOLUTE REFERENCING.** Use absolute referencing when you do not want a cell reference in a formula to adjust to its new location when you copy the formula. The row and/or column reference is locked so it cannot change when copied.

For example,

When you copy the formula \( =\text{Sum}(B2:B5) \)

from cell B6 to C6 it changes to \( =\text{Sum}(C2:C5) \)

It is using **relative referencing**.

You may wish to think of this formula in this way – it is instructing Excel to sum the values in the 4 cells above. So if you copy the formula to another cell the arguments change so that the formula will still be instructing Excel to sum the values in the 4 cells above. This automatic change in the formula is very useful and cuts down the effort when copying formulas around.

But take great care as the use of relative referencing does not ALWAYS give you what you want when you copy the formula.

For example,

If you create a percentage formula in cell C2

\( \frac{B2}{B6} \)

And then copy it down to the cells below the formula, the formula will be incorrect in every cell you have copied to.

i.e. if you copy the formula to the cell below you will get \( B3/B7 \). But there is no value in cell B7 so the formula ends up with a 0 as the denominator. Hence you get the symbol DIV/0! indicating an error.
To correct the initial formula you need to make the denominator have **absolute referencing**. To do this insert your cursor by the B6 of the formula and press the function key **F4** on your keyboard. This will have the effect of placing a dollar sign in front of both the B and the 6. You could alternatively type in the dollar signs instead of using the F4 key.

Making B6 an absolute reference will ensure that whenever the formula is copied both the B and 6 will remain constant.

Now if you copy the formula with the absolute reference down that column you will see that the formula will be exactly as you require it in every cell.

**TIP:**
It may be sometimes necessary to only make the column reference absolute or the row reference absolute. In this situation you would need to have either $B6 or B$6. To achieve this either type the dollar sign where it needs to go or click by B6 in the formula and press the **F4** key until you get what you require. i.e. pressing F4 repeatedly will toggle between $B$6, $B6, B$6, B6

### AutoFill

AutoFill is a quick and easy method you can use for copying data or formulas.

**To Perform an AutoFill**

1. Select the cell which has the text, data or formula you wish to copy.

   The active cell will have a small black box in the lower right corner and this is referred to as the **Fill Handle**.

2. Point the mouse at the fill handle. When the mouse pointer is directly over the Fill Handle it changes to a black cross indicating that you are now ready to click and drag.

3. Click and drag in any direction to start filling in values into the cells you are dragging over.

4. Release the mouse button.

The cells you dragged over are now filled with copies of the text, data or formula.
THE AUTOFILL OPTIONS BUTTON
When you let go of the mouse button after you have performed an AutoFill the **AutoFill Options** button will appear.

Place your mouse over this button and click to display a drop down menu from which you can select various options, some which may alter the AutoFill text. For example, you may select to go for a simple copying of the information or you may wish to keep/discard the formatting.

TIP:
AutoFill is also an invaluable tool for filling in a data series, thereby saving you lots of time. For example, you may fill in a column with the days of the week, months of the year or a series of dates using AutoFill.

For further details on creating a data series refer to the *Excel 2014 – Beyond Basics 2* guide.

Page Margins

Page margins are the areas around the edges of the page where text will not normally go. You can change each of the four margins independently to any size you require. It is common for left and right margins to be set quite small to allow more columns to fit on one page when preparing worksheets for printing. Several methods exist for changing page margins.

**USING THE PAGE SETUP DIALOGUE BOX**

1. Go to the **Page Layout** tab, and locate the **Page Setup** group.
2. Click on the Page Setup group dialogue box launcher button.
4. Change the values for the Top, Bottom, Left and/or Right margins.
5. Click OK
**Using the Margins Button**

1. Go to the Page Layout tab and locate the Page Setup group.
2. Click on the Margins command button
3. Select from one of the preset margin options provided.
   Or,
   Click on the Custom Margins option and set your own margin sizes from the dialogue box which appears.

**Using Print Preview**

For details on this see the Print Preview section below.

---

**Page Orientation**

The default page orientation is Portrait. If you are going to print your worksheet you might find that the Landscape orientation is the most suitable orientation and will use less pages.

**To Change Page Orientation**

1. Go to the Page Layout tab and locate the Page Setup group
2. Click on the Orientation button and select the orientation you require.
   Alternatively, click on the Page Setup group dialogue box launcher button, select the Page tab and select the orientation you require.

---

**Print and Print Preview**

It is very useful to be able to view your worksheet as it will be printed before you go ahead and print it. This can save you a lot of time, paper and toner. You can immediately identify blank pages, empty spaces, incorrect margin settings, unwanted headers etc. The Print Preview features has been merged with the Print command for Excel 2013.

**To Switch on Print Preview**

1. Click on the File tab
2. Select Print
3. If necessary, select the
   - Number of copies to print
   - What you wish to print, E.g. active sheets, entire workbook or selection
   - Pages to print
     E.g. 1-4, 1, 5, 7-9

4. Press Print button when you are ready

The Print Preview pane

Switch on margins button

TIP: you can resize the margins, headers/footers and columns by clicking and dragging the square handles in the preview area